Maple Tutorial #1: Getting Started *

Scott R. Fulton and Christos A. Xenopontos
Department of Mathematics and Computer Science
Clarkson University
Maple V Release 5
Fall 1999

Introduction

Maple is a powerful computer program which allows you to do mathematics symbolically, numerically, and graphically. Working through these tutorials will provide you with a basic introduction to Maple. The goal of this first tutorial is to learn how to:

- Start (and exit) Maple
- Get help within Maple
- Type in simple Maple commands
- Use Maple as a fancy calculator
- Perform some basic algebra

To get the most out of this tutorial, read the text carefully and try the commands as shown. Don’t be afraid to experiment—nothing you type to Maple will damage the computer.

Starting (and exiting) Maple

Maple runs on a variety of computers, with very few differences on different systems. Here we cover the two most common systems: PCs running Windows 95/98/NT and Unix workstations.

*Technical Report 99-03, Department of Mathematics and Computer Science, Clarkson University, Potsdam, NY 13699-5815.
On a PC running Microsoft Windows: Click on the Start button (lower left corner), then choose Programs by clicking and find the Maple program group. To start Maple, click on the Maple V Release 5 button.

On a Unix workstation: First, you must login to the computer. Usually you will find a small window on the screen with prompts for your login name and password. Type them in, and you will end up logged in with the X-window system already running. Then start up Maple by selecting it from the Root Menu: use the mouse to move the cursor to the background, press and hold the right mouse button, slide down to highlight the selection labeled Applications, choose MapleV, and release the button. A window for Maple should appear soon.

On some Unix workstations, instead of a window with the login name and password prompts, you may find simply a prompt saying login: (usually at the bottom of the screen). In this case, type in your login name; when prompted for your password, type it in. Then type xinit to start up the X-window system. You can then select Maple from the Root Menu as described above. It’s also possible to start up Maple (once you are logged in) by typing “xmaple &” in a Unix window. If nothing happens when you type, first use the mouse to move the cursor into a window, then click the left mouse button and try typing again. The ampersand “&” puts Maple in the background, so you can use the same window for other commands without having to exit from Maple.

Exiting Maple: On any system, the Maple command quit will do just that. On most systems, you can also quit by selecting Exit from the File Menu (top left corner).

On a Unix workstation, you must also logout. Move the cursor to the background, pull up the Root Menu by holding down the right mouse button, and select End Session. When the screen clears, if you end up with anything other than the login prompt you started with, type logout. Finally, turn off the monitor (but not the computer!).

The Worksheet Interface

Maple V Release 5 uses what is referred to as worksheets. Several worksheets can be opened simultaneously, so if your workspace disappears behind a new worksheet (or help screen) don’t panic ... use the Window Menu (usually next to Help Menu) and you’ll find several options to help you rearrange your worksheets. There are plenty of other advantages in using the new worksheet interface but we will not get into that in this tutorial.

Help!

Maple has an extensive online help facility. Click on the Help Menu (upper right) and you’ll find several options. The Help Browser organizes help on most Maple commands into various groups. The Help Menu also includes a Keyword Search and some other helpful options (try it).
Maple Tutorial #1

It’s also possible to get help for a specific command by typing ?<topic> at the Maple prompt (the symbol > at the left side of the screen). For example, type:

> ?help

to get help on using the help command itself (press the Enter key to enter the command into Maple). If you don’t know the name of the command you need, Maple can sometimes provide some suggestions. For example, type:

> ?mat

There are no matching topics. Try one of the following

match matlab matrices matrix Matlab MatlabMatrix

For further help, you may want to look at one of the many books on Maple; several are listed at the end of this tutorial.

Entering Maple commands

You’ve already seen two Maple commands: quit and ?. These commands are the only common exceptions to the rule: always end a Maple command with a semicolon (or a colon, if you don’t want to see Maple’s response). A common error is to leave off the semicolon—then Maple waits patiently until you type it (Maple will also wait patiently until you press the Enter key). So without further ado, let’s start exploring Maple ...

Maple as a calculator

Maple can be used as a calculator in the familiar way, with * for multiplication and ^ (or **) for exponentiation. Try the following examples and see that Maple produces the output listed here:

> 2+3;

> 4*12
>
Warning, premature end of input

Since we forgot the semicolon, Maple hasn’t produced any output yet. In addition, a warning statement is issued and a (possible) solution to our error was provided. To fix this, enter the semicolon it is waiting for on the next line (where the blinking cursor is) (and press Enter, as always):

> ;

5

48
Try typing the following:

\[
> 6 - 4*5^2;
\]

\[-94\]

Note that Maple does the operations in the standard order: exponentiation first, then division and multiplication, then addition and subtraction. To change the order (or when Maple has trouble interpreting your input), use parentheses:

\[
> ((6 - 4)*5)^2;
\]

\[100\]

Many other mathematical operations are possible using Maple functions, such as `sqrt` for the square root of a number:

\[
> \text{sqrt}(2);
\]

\[
\sqrt{2}
\]

This example follows the general syntax of Maple: a command name, followed by one or more arguments enclosed in parentheses (and terminated by a semicolon). Incidentally, although Maple calls such commands “functions” or “procedures” (following computer programming terminology), we will refer to them as “commands” to avoid confusion with the concept of a mathematical function.

The above example illustrates one difference between Maple and a calculator: Maple can use exact arithmetic. Try the following examples (note that more than one command can be put on one line, as long as each command ends with its own semicolon):

\[
> 2^{-72}; \ (2/5)^{48}; \ 3^{\,(1/2)};
\]

\[
472366482869645213696
\]

\[
281474976710656
\]

\[
3552713678800500929355621337890625
\]

\[
\sqrt{3}
\]

Even when the result is not a rational number, Maple resists computing a floating-point (decimal) approximation unless you specifically request it. To do so, either use decimal points in the input values or use the function `evalf` (for “evaluate to floating-point”). For example:

\[
> (2.0/5.0)^{48}; \ \text{evalf( } 3^{\,(1/2)} \ ));
\]

\[
.7922816251 \times 10^{-19}
\]

\[
1.732050808
\]
If you want more digits, just ask—an optional second argument to evalf specifies the number of digits (the default is 10):

```maple
evalf( 3^(1/2), 30 );
1.73205080756887729352744634151
```

Maple also knows some special numbers. For example, the ratio of the circumference to the diameter of a circle is

```maple
> Pi; evalf(Pi,25);
```

\( \pi \)

3.141592653589793238462643

(note the spelling: you need Pi, not pi or PI). The number \( e \) (the base for natural logarithms) is known to Maple as \( \exp(1) \) (i.e. \( e^1 \)):

```maple
> evalf(exp(1));
```

2.718281828

Finally, you may find the imaginary unit \( i = \sqrt{-1} \) popping up (even when you’re working with real arithmetic); Maple denotes this by I:

```maple
> sqrt(-1);
```

\( I \)

### Errors, editing, and such...

Maple can only respond to what you type, and sometimes you won’t get the response you wanted. For example, if you leave off a parenthesis, Maple will complain:

```maple
> evalf( 2/3)^2 );
'\)\) \text{ unexpected}
```

Note that Maple tries to point out the error (by placing the blinking cursor at the place of the missing parenthesis)—sometimes this will help you find the problem (and sometimes it won’t). Here, the problem is that the last right parenthesis doesn’t have a matching left parenthesis:

```maple
> evalf( (2/3)^2 );
```

.4444444444
As you may suspect, you don’t have to retype the whole command; you can simply use the mouse (or cursor keys) to go back to the offending command, correct it (using the backspace and/or delete key as needed) and then press the return key again.

Sometimes Maple simply spits back what you typed in:

> Evalf(Pi);

Evalf(π)

This is Maple’s way of saying “I don’t understand this.” The problem here is that Maple is Case SensITIVE: it knows the command evalf, but not one named Evalf. Thus, you must be careful—use capitals only where they are required. Try fixing this command up by going back to the line you typed (use the mouse or the arrow keys), change the E to an e, and press Enter again (the cursor doesn’t need to be at the end of the line). You should obtain:

> evalf(Pi);

3.141592654

Sometimes you will want to use the result of a previous computation again. Maple uses the percent sign (%) (located on top of the number 5 and obtained by pressing Shift 5) to do this. For example, to compute π² (assuming you have been typing the commands as shown), you can simply say:

> %^2;

9.869604404

You can also use two percent signs (%%) to refer to the result before that, and three (%%%), for the result before that, but be careful: as you execute each command, the one which is the previous command—and thus the meaning of %—changes (try it!).

Finally—always remember to end each command with a semicolon;

**Algebra**

Now things get a bit more interesting. Maple is perfectly happy to deal with variables:

> x^2 - 3/x + 4*x;

\[ x^2 - \frac{3}{x} + 4x \]

Note that while we must use the asterisk * to denote multiplication, Maple displays its output in the standard mathematical form without the asterisk (using this form for input would be a mistake). Variable names need not be a single letter—you can use a word and/or include digits (except as the first character):

> dragcoeff*speed^2;

\[ \text{dragcoeff} \text{speed}^2 \]
However, be careful with names: do not use any word that might be a command (like sqrt). Maple may allow you to redefine such a name as whatever you want, and then the original command is lost. The only way to get it back is restart Maple by quitting and starting over (try this some other time).

It’s often very convenient to give a name (or label) to an entire algebraic expression, so that we may use it again and again without retyping it. We do this with the assignment operator := (note: there is no space between the colon and the equals sign):

\[ \text{expression1} := x^2 - 6x + 9; \]

\[ \text{expression1} := x^2 - 6x + 9 \]

Note the use of a 1 in the variable name—this is one way to avoid possibly redefining existing command names. To see the “value” of the name, simply type the name followed by a semicolon:

\[ > \text{expression1}; \]

\[ x^2 - 6x + 9 \]

A specific value may also be assigned to a variable or name. Keep in mind that the name is no longer variable, but is now a constant:

\[ > x := 4; \]

\[ x := 4 \]

If we now ask for the value of expression1, Maple substitutes 4 for \( x \) and returns a number:

\[ > \text{expression1}; \]

\[ 1 \]

Unfortunately, now we can no longer algebraically manipulate the expression stored in expression1 because \( x \) is no longer variable. We can get back to using \( x \) as a variable by “unassigning” it as follows:

\[ > x := 'x'; \]

\[ x := x \]

(note that the symbol ‘ is the single (forward) quote, located on most keyboards just to the right of the semicolon key). Now \( x \) is a variable again, as we can verify:

\[ > \text{expression1}; \]

\[ x^2 - 6x + 9 \]
To substitute a value for a variable without assigning it directly, we can use the Maple command subs:

> subs(x=4, expression1);

1

Note that the first argument is an equation specifying the substitution to be made, and the last is the expression into which the substitution is to be made.

Maple can do all of the typical operations which you learned in algebra (and then some). For example:

> factor(expression1);

\((x - 3)^2\)

factors the polynomial defined above. To multiply it back out (without having to retype it) you can simply say:

> expand(\%);

\(x^2 - 6x + 9\)

(recall that the percent sign \% refers back to the result of the previous Maple command). We could also combine commands like this on a single line if desired:

> expand((x+1)^7); factor(\%);

\(x^7 + 7x^6 + 21x^5 + 35x^4 + 35x^3 + 21x^2 + 7x + 1\)

\((x + 1)^7\)

These examples show that factor and expand are inverse operations, just as expected. Another useful command is simplify (often used to combine fractions):

> simplify(1/x + 1/x^2);

\(\frac{x + 1}{x^2}\)

You may find that simplify doesn’t always do what you expect; in these cases, the related command normal sometimes produces the answer you would like.

**Review**

By now, you should know how to: start (and exit) Maple, get help, and use Maple as a fancy calculator and to do some algebra. The Maple operators, constants, and commands we have seen so far are summarized in the tables on the following page. Maple has many more commands for algebra, and for many other areas of mathematics. We will see some of these in the next tutorial.
References

Many books have been written about Maple. Good places to start include:

- *Exploring Calculus with Maple* by Artino, Kolod, Evans, and Johnson (Wiley, 1994). A book of solved problems and exercises used in calculus classes, this also contains an introductory Appendix on Maple.


For more in-depth work with Maple (especially programming) the following may be helpful:


Basic Arithmetic Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>addition</td>
</tr>
<tr>
<td>-</td>
<td>subtraction</td>
</tr>
<tr>
<td>*</td>
<td>multiplication</td>
</tr>
<tr>
<td>/</td>
<td>division</td>
</tr>
<tr>
<td>^ or **</td>
<td>exponentiation</td>
</tr>
</tbody>
</table>

Basic Numerical Constants

<table>
<thead>
<tr>
<th>Constant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pi</td>
<td>the number $\pi = 3.14159\ldots$</td>
</tr>
<tr>
<td>exp(1)</td>
<td>the number $e = 2.71828\ldots$</td>
</tr>
<tr>
<td>I</td>
<td>the imaginary unit $i = \sqrt{-1}$</td>
</tr>
</tbody>
</table>

Basic Maple Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>quit</td>
<td>exit Maple</td>
</tr>
<tr>
<td>?&lt;topic&gt;</td>
<td>get help on &lt;topic&gt;</td>
</tr>
<tr>
<td>sqrt( )</td>
<td>square root function</td>
</tr>
<tr>
<td>evalf( )</td>
<td>convert to floating-point (decimal)</td>
</tr>
<tr>
<td>x := y;</td>
<td>assign the value y to x</td>
</tr>
<tr>
<td>x := 'x';</td>
<td>unassign x</td>
</tr>
<tr>
<td>subs( x=c, expr );</td>
<td>substitute value c for x in expr</td>
</tr>
<tr>
<td>expand( expr );</td>
<td>expand the expression expr</td>
</tr>
<tr>
<td>factor( expr );</td>
<td>factor the polynomial expression expr</td>
</tr>
<tr>
<td>simplify( expr );</td>
<td>simplify the expression expr</td>
</tr>
<tr>
<td>normal( expr );</td>
<td>an alternative to simplify</td>
</tr>
</tbody>
</table>

Remember:

- Always end each command with a semicolon.
- Use capital letters only where needed—Maple is Case SensiTIVE.